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“The more you know about the other platform, the 
more you know about your own!” 

-- Knute Holian 6/10/96, Skill Path Seminar --

Some Words about Macs and PCs
Many schools face the much debated dilemma: should they become cross platform. More often 
than not, the schools were originally all Macintosh and now for a variety of reasons - Trustee 
pressure, parental pressure, cost factors, support issues - must consider adding PCs to the mix. 
The major stumbling block is cost; we don't mean the cost of the purchase, but the hidden costs 
of training previously successful Macintosh users, purchasing software for the new PC 
environment, training the previously Macintosh skilled computer coordinator in the new 
technological environment, and the major amount of time involved in setting up new labs with 
new networking systems, new peripherals, and new headaches.

While we don’t have the answer to all the problems raised, we do have some suggestions. One, 
most CDs are now hybrid - combining both Mac and PC install programs, so give high priority to 
cross platform software. Also many favorite Mac programs, like AppleWorks or First Class, have 
PC versions that are fundamentally the same; similarly, PC software frequently, although not 
always, has Mac equivalents, like MS Office. So the easiest way to proceed is to focus more on 
standardizing software: for instance, both Macs and PCs run AppleWorks, First Class, 
PhotoShop, MS Office, and Inspiration.
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Shared Mac/PC concepts
Another suggestion is to stress in PC training that the Windows environment is similar to the 
Mac operating system and the two systems share features. After the initial dismay of seeing the 
different desktops, users can learn that much of the vocabulary remains the same: desktop, 
folders, files, etc. and that the skills of navigating to folders, Save vs. Save As, and using 
keyboard shortcuts are not fundamentally different. 

Macintosh PC Equivalent

Hard Drive on the desktop to see files, folders, and 
programs

My Computer on the desktop to see files, folders, and 
programs 

Go menu Start Button
System Preferences under the Apple Menu Control Panels under Start Button, point to Settings, 

choose Control Panel from submenu

Red, yellow, green buttons on left hand corner Minimize button on right hand corner to shrink to taskbar 
to show and hide applications

Keyboard shortcuts with Command and Option Keyboard shortcuts with Control and ALT
Moving and resizing windows with title bar and 
click-dragging corner

Moving and resizing windows with title bar and click-
dragging corner or sides

Dock Taskbar
etc. Recycle Bin to delete files, folders, etc.
Red button on top left corner of window Close Box on top right corner of window
Double click to load files or programs Double click left mouse button
Aliases Shortcuts
Contextual shortcut menus with Control-Click on 
files, folders and applications

Contextual shortcut menus with Right Mouse-Click on 
files, folders and applications

Mouse Control Learn to distinguish between single click, double click and dragging. Single-
Clicking blackens a file or makes a choice. Double-Clicking opens a file, highlights a word or 
starts up an application. This is the basic logic, but it takes time - like riding a bicycle - to build 
up your intuition regarding single vs. double-click. When in doubt, use single-click. If nothing 
happens, be more aggressive and double-click. Selecting text and then clicking the mouse and 
keeping the mouse button held down, and then rolling the mouse so that the cursor is at a new 
location and then releasing the button is called Dragging and Dropping.

PC Versus Mac Mouse One major difference between the Macintosh and PC environment is the 
use of the mouse, with the PC mouse taking advantage of both a left and right mouse button. The 
left mouse button functions similarly to the single Mac button, the button to use to select files, 
folders, etc. and the one to use when double clicking. The PC mouse takes advantage of the right 
mouse button to provide contextual shortcut menus when clicked on files, folders and 
applications. Macs actually have the equivalent function of contextual menus with the addition of 
holding down the CTRL button while clicking on an icon. Use this feature to save time.

The Desktop Finder or Desktop on PC  The screen with the trash can or Recycle Bin is 
called the Desktop Finder on the Mac or Desktop on a PC. From here you can double click on a 
disk or folder to open it or you can double click on an application to start it. In both 
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environments, you can use the desktop as a storage place for Aliases or Shortcuts to files and 
folders that you want available for immediate access. 

Key Points Important keys on the Mac include Option, Command, and Ctrl. Remember to hold 
down the Option button or the Command button while you push and release another key. On the 
PC, the equivalent keys are the ALT, CONTROL (abbreviated CTRL at times), Tab and Function 
Keys marked F1, F2, F3, etc. 

Folders vs. Files Files are specific documents that you create with your software when you 
Save. Folders are containers or cubbies that you create to hold and organize your files. 
• To create a New Folder from the Desktop Finder in the Mac, first open your disk or desired 

window. Then choose New Folder under the File menu. When it appears highlighted as Untitled 
Folder, do not mouse-click; just type in the Folder name and push Return. 
•  To create a New Folder from the Desktop on the PC, right mouse click on an empty part of the 

desktop and choose New, then Folder from the contextual menu. Or similar to the Mac, you can 
go to the File Menu, then New, then folder.

Saving Remember The Rule of Three when saving: 
• SAVE with a descriptive file name
• SAVE onto the correct disk (hard drive, file server, memory stick or floppy disk)
• SAVE within the correct folder
Do not push Return or click the Save button until you are satisfied that you have obeyed the Big 
Three. In Boston, we remember the big three — Larry, Kevin and Robert — who won 3 
championships in 81, 84 and 86 and the big three — Paul, Kevin and Ray — who won in 2008.

Save vs. Save As When you have not yet saved, the two choices are identical and cause 
the computer to give you the Save As dialog box. Once you have saved a document correctly by 
always keeping the Big Three in mind, choosing Save instructs the computer to save as before — 
same disk, folder and file name.
• In contrast, the Save As choice is a request on your part to change one or all of the Big Three. 

By choosing Save As, you access the Save As dialog box and can change any of the 3 items. 
Using Save As is desirable when you want to change the file name or when you want to save a 
second time in a different folder or when you want to make a backup by saving onto a second 
disk (floppy or hard). 

The Rule of Four When you save a file, you are saving in the standard format preferred 
by the software company. However, many times, it is advantageous to save your file in a 
different format so that some other software can access it. We at Summercore call this the rule of 
four. If you save a Word document as RTF or save an Excel spreadsheet as a CSV file, you are 
practicing the rule of four. Saving a JPG file from PowerPoint or Photoshop is practicing the 
rule of four. A user of the latest 2008 Microsoft Word software may need to practice the rule of 
four so that the file is a DOC file and not a DOCX file if the recipient is using older software.
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Backing Up
Good Backup Habits
Good habit #1: Save your work every 15-20 minutes. This protects you if the power should go 
off, a phenomenon that always occurs without warning. Always save when you think of it. Do 
not try to do one more thing before saving. This involves nothing more than choosing Save 
(Command-S on the Mac or CTRL-S on the PC) frequently. Save on more than one disk - using 
Save As - especially when finished with that particular document for the day. 

Good habit #2: Never work with just one storage destination. When you are done with a project 
for the session and have saved for the last time onto the main storage disk, make sure you save 
for a second time onto another location: a file server, a USB drive, an e-mail account, Time 
Machine for the Mac, or a web-based hard drive account. Just be sure to save in more than one 
place. Don't rely on the file server or an e-mail account solely. 

Good habit #3: Save different versions of the same file. When you are working on an important 
file, one that you return to frequently or when your students are working on an essay or any 
project, be advised to save that file in different versions. Perhaps at the end of day one, use the 
Save As feature to save your file- let's say the file name is PrimerChapter 11-with a new name, 
like PrimerChapter 11 v.2. Then the next day after you have worked on version 2, use Save As 
again and now rename the file PrimerChapter 11 v.3, and so. This way if the file becomes 
corrupted you can always go back to an earlier saved version of the file, a version that was saved 
before any corruption occurred.

Folder Skills: Navigating
In order to save well, you need to learn to work with folders. You need to learn the skills of 
creating new folders, saving into a specific folder, loading files from folders and moving files 
from one folder to another. Saving in the appropriate folder is one of The Big Three. For lack of 
a better name, we shall use the word navigating for the skill of saving a file into a specific folder. 
First you need to save on the correct drive; using the Mac, you would choose the Hard Drive 
Icon. After you navigate to the appropriate drive, you will see a list of the available folders to 
save in. You must double-click on the folder name to make that folder rise to the top, so to speak, 
and then that folder becomes the open or active one. You must make sure that the appropriate 
folder is open before you press Return to Save or before you click in the Save Button. In the PC 
environment, you would choose the C: Drive, then click the down arrow next to the box “Save 
In” and choose the correct folder and then the correct folder.
When you Open a file, you use the same navigating skills, first getting to the desired folder. By 
the way, when opening a file from within your software, pushing Return is the same as Double 
Clicking; pushing a letter from A to Z means go to that alphabetical position in the listing.

Showing and Hiding Applications Using the minimize button on both the Mac and PC, you 
can hide your current document or application and then open another application thus allowing 
you to work with more than one application at a time; the fancy term for this is multi-tasking. In 
Mac OS X, you can also choose Hide from the Application Menu on the window title bar. 
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For example, you are on the Web, using Firefox, and you want to copy information from the 
website into your word processor. First you select and copy the text or graphic. Then click on the 
yellow button on the Mac or the Minimize button on the PC. If Word is not open, then open 
Word from the Dock or the Start Menu, create a new WP document, and choose Paste from the 
File menu. The Web selection will fly in. Now to return to the Web, go back to the Dock or 
Taskbar and click on the previously minimized application. 

Some Macintosh Specifics
Three ways to load a file should be part of everyone’s repertoire, like getting into a house via 
the front door and the back door. The front door method involves double-clicking on the specific 
file. The back door method involves starting up your software and then navigating and loading 
up the desired file. Third way is dragging and dropping the file icon onto the icon on the dock of 
the desired application. In other words, drag a doc file onto the “W” for Word icon.

Apple Menu Items or Desktop Accessories: In OS X, most desktop accessories are in the 
Applications Folder. Most are found in System Preferences, the Dock, or under the Go menu in 
the Utilities folder. The calculator is in the Applications folder or a Widget on the Dashboard.

Finding Key Caps in OS X: Finding Key Caps is no longer so obvious. Go to System 
Preferences and click on International. Then click on the Input Menu. Check the two boxes next 
to Character Palette and Keyboard Viewer and be sure "Show input Menu in menu bar" is 
checked. Close the window. An American Flag will appear in your menu bar. Choose " Show 
Keyboard viewer" 

Windows Specifics
Windows learns which files are used most often and arranges the hard drive so that these files 
will open quickly. Windows machines use the Taskbar as the main control station. The Taskbar 
contains the Start Button- similar to the Apple Menu- that provides shortcuts to most programs 
and applications. From the Start Button you can access programs, the most recently opened 
documents, the Settings folder to alter printers and other hardware and peripherals and control 
panel items, the Find application, and Run which aids in the installation of programs. 

In addition to the Start Button, the Taskbar has a quick launch toolbar to allow for easy access to 
open applications. Right-mouse clicking on an empty part of the taskbar causes a shortcut menu 
to appear that will allow you to organize the PC Desktop. Right-mouse clicking on an empty part 
of the desktop, or on the icon of a folder, file, or drive will reveal a contextual short cut menu. 
The Taskbar is usually at the bottom of the screen, but it can be moved to anywhere on the 
screen. Clicking and dragging on the top border of the Taskbar will resize it to allow more room 
for minimized application icons. If the Taskbar is not visible, move the mouse to the bottom of 
the screen and a gray bar with the Start Button- i.e., the Taskbar- will appear. If the Taskbar does 
not appear on all windows in all applications, go to the Start button, then Setting, then Taskbar 
and click the check box labeled Always on top so the Taskbar will be seen on all windows. 
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Windows allows for customizable Taskbars; you can add an address bar for easy Internet access. 
Windows XP can also be customized to have the traditional Start menu look by right-clicking in 
the Start button, choosing properties, then choose Classic Start Menu.

Windows XP offers many different ways to open an application: double click on a desktop icon; 
right mouse click on an icon to choose Open; go to the Start menu to choose a listed application 
or choose All Programs from the Start Menu. One way is not preferable to the other, so don’t 
make yourself crazy. It is important to realize that all computers offer multiple ways to 
accomplish the same task. so simply choose the one way that works for you.

To gain easy access to recently opened documents, go to Start Menu to choose My Recent 
Documents. Macs, by the way, have the same feature under the Apple Menu. (See Macs and PCs 
are not so different.)
 

Installing Software
On a Macintosh (Read Your Manual First or try the Read Me file)
• Method #1 (easiest) involves inserting CD-ROM, clicking on Install and following instructions. 
• Method #2 involves creating a folder on your hard drive, naming it, and then inserting the CD 
into the disk drive and dragging the necessary files into the New Folder. By using the Shift key 
trick or choosing Select All under Edit, you can drag all the files at once. 

On A PC (Read Your Manual First or try the Read Me file)
• Method #1 (easiest) involves inserting the CD-ROM, which begins to run instantly using its 
autoplay feature.
• Method #2 After inserting CD or software, go to Start Button and choose Run and then choose 
Browse to look for an install program; usually that application is named install.exe or setup.exe. 
Or go to My Computer, click on the D: drive for CD-ROM and double-click on the install 
application.
• Method #3 Go to the Start Button, then Settings, and then Control Panel; double click the Add/
Remove Programs Icon. Click Install. If the Setup Program file is displayed, then click Finish. If 
it is not displayed, then click Browse to find the file. Then click Finish. Follow any instructions 
displayed. 
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JV PROFICIENCY SKILLS: MAC/WIN
 

Aliases/Shortcuts?File size? Open window? Viewing Files?
Backup a file? Format a disk? Print sideways? Window ... change size
Backup files/fldrs?Keystroke shortcuts? Renaming? Window ... close!
Calculator? Load a file? Save vs Save As? Window ... make active
Closing an application?Locking a disk? Scroll Bars? Window ... move
Deleting? Mouse Tricks? Searching? Window ... resize
Dialog box? New Folder? Show/Hide applicationShow/Hide application
Disk space? Open application? Turning Off?

Aliases/Shortcuts?  Mac- The Alias is a signpost pointing to the actual application. 
Drag and Drop the application’s (or file’s) icon onto the Dock. To 
remove from Dock, simply drag and drop the icon off the Dock and 
Poof, the alias disappears. If you want an alias on the desktop, 
select any file or application, and choose Make Alias under the File 
Menu. The original file (perhaps 500K) now has a 1K companion 
file which can be put in a different folder. Double clicking opens 
that file or application. 

  Windows- The Shortcut is a signpost pointing to the actual 
application. Right-mouse click the file or application; hold down 
the mouse button and drag onto the desktop. Before releasing, 
choose the Make Shortcut Here option. (Think of this procedure as 
Right Button Dragging.)

Backup a file?  Mac- Insert the flash drive or CD. Click on the file to be copied 
and drag it to the flash drive icon. Release the mouse when the icon 
darkens, not before. If you have a CD burner, drag and drop the file 
onto the CD icon, drag the disk to the trash, and then follow the 
Burn directions.

  Windows- Insert the flash drive or CD. Select the file to be copied. 
Hold down the right mouse button; choose Send To. Click the flash 
drive or CD choice on the pop up menu. The Flash Drive icon will 
appear in My Computer, so you can also drag files onto the icon.

Backup files/fldrs?  Mac- To select a number of files from the desktop, click on the first 
file, hold down the Shift button and then continue to click on the 
additional files. To select noncontiguous files, click on the first file, 
hold down Command (Apple) Key, then click on the other files. 
Once they are all selected, click on any one of the files and then 
drag and drop onto the flash drive icon or a folder on your file 
server. Some people can use their e-mail account as a storage 
device or burn their files onto a CD drive.
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  Windows- To select a number of contiguous files from the desktop, 
click on the first file, hold down the Shift button and then click on 
the last file in the series and all the files will be selected. To select 
noncontiguous files, click on the first file, hold down CTRL Key, 
then click on the other files. Drag and drop onto floppy disk icon.

Calculator?  Mac- The Calculator can be found in Applications Folder. Under 
Go Menu, choose Applications or locate the Applications folder on 
your hard drive. You can change the kind of calculator by going to 
the View menu to include math and binary functions.

  Windows- Click and hold on the Start Button on the Taskbar, then 
Programs, then Accessories; you will find a drop down menu that 
includes the Calculator. When the Calculator is darkened, release 
the mouse and the Calculator will appear on your desktop. 

Closing an application  Mac- An application that has been minimized onto the Dock can be 
quickly closed by clicking and holding on its icon in the Dock. A 
pop-up menu will appear giving the choice to Quit the application.

  Windows- Right Mouse Click on the minimized icon on the 
Taskbar to choose Close. 

Deleting?  Mac- From the desktop, click on a file or folder to select (or use the 
Shift-click trick to select more than one) and then drag and drop 
onto the Trash can icon. Do not release until the Trash can darkens.

  Windows- From My Computer, click on files or folder (or use the 
Shift-click trick to select more than one or the Control-click trick); 
press the Delete key, and click Yes in the dialog box. From the 
desktop, you can drag and drop onto the Recycle Bin icon. 

Dialog box?  Mac and Windows- When you have many choices on a dialog box, 
you can cycle around the screen by pushing Tab rather than 
clicking the mouse after each entry. Frequently the Return key 
kicks you out of the screen, so using Tab is preferable.

  Windows- Pressing Space Bar will activate a button in a dialog box 
if it is selected. 

Disk Space?  Mac-Disk Space is found on the bottom of every open folder.
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  Windows- Open the My Computer window and right-click on the 
floppy drive icon and choose Properties from the pop up menu. 
The General tab shows the amounts of used and available space. Or 
you can see this information in the lower right hand corner when 
Hard Drive is clicked.

Ejecting a CD/flash drive? Mac- From the desktop, drag icon to the Trash can

  Windows- Push eject button or remove flash drive.

 Mac/Windows If the file is in use, then you will not be allowed to eject the disk — 
you will need to close the file or quit the application first! 

File size?  Mac- Set the folder directory to List View; if the View Menu is set 
to Icon or Small Icon, then this info will not appear.

  Windows- At the desktop, hold down ALT while double clicking on 
any file, folder or icon. The properties box appears with much 
information, including file size. Or right mouse click to get 
Properties.

Format a CD?  Mac- Insert a blank CD and a dialog box will open automatically 
asking you to name the CD.

  Windows- Double click on My Computer icon, and then right-click 
on the floppy disk drive icon. Choose Format from the menu that 
pops up and then choose the options you want: Quick Erase to 
delete all files or Full to format the disk.

Keystroke shortcuts?  Mac- Holding down the Command key plus a variety of different 
keys is a shortcut that avoids using menu items. For instance, 
Command-S is Save, Command-X is Cut, Command-V is Paste 
(remember V for Velcro), Command-C is copy. In each of the 
menus, next to the commands, you will see the keystroke shortcuts.

  Windows- Holding down the Control key plus a variety of different 
keys is a shortcut that avoids using menu items. In many cases 
Command on the Mac equals Control on Windows. For instance, 
Control-S is Save, Control-X is Cut, Control-V is Paste (remember 
V for Velcro), Control-C is copy. The Alt key also can be used for 
shortcuts, as in Alt+backspace for Undo, Alt+F for File menu, Alt
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+F+O to Open File, Alt+F4 to close. The keyboard equivalents 
appear in each menu next to the command.

Load a file?  Mac- Find the file on your hard disk and double click; the file and 
its application will open. If the file was recently opened, then go to 
the Apple Menu, then Recent Items.

 

  Windows- Double click on My Computer; navigate to the 
appropriate drive and folder and double click with left button. If 
the file was recently opened, then go to the Start Menu, My Recent 
Documents.

 Mac/Windows If a file won't open using the front door approach, then open the 
application first. To open a word processing document, you would 
first open AppleWorks or Word or the Office folder, and then 
choose Open from the File menu. We call this the back door 
approach! Use your navigating skills to find the document. You 
may have to click on the drop down menu of filters in the dialog 
box to find appropriate conversion filter, and then Open the 
document. 

Mouse tricks?   Mac- Most Macintosh mice have one button; you single click to 
select a file, icon or application; you double click to force an 
action, i.e. open a file or folder or an application; you drag and 
drop to move a file, graphic or folder. You can control-click on files 
and folders to get a shortcut menu.

  Windows- PC mice usually have two buttons; the left button 
functions similarly to the Mac single button for immediate actions 
of opening files, folders and applications; the right button is for 
secondary actions, e.g. creating shortcuts or copying files. The 
right button is dynamic, changing menu choices depending where 
the mouse is pointing: on an application, file, folder, Taskbar, or an 
empty spot on the desktop 

New Folder?  Mac- If your hard drive is not open, the folder will be created on 
your desktop, so first open the hard drive to create the folder on the 
main directory or open another folder to create a folder within a 
folder. Then at the desktop, under the File menu, choose New 
Folder. Immediately type in a name for the folder and then press 
Return. Most applications have the option to create a new folder 
from the Save or Save As dialog box.
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  Windows- Open the window of the directory destination - either a 
folder or a drive - and then right mouse click on an empty part of 
the window. Point to New and then choose Folder on the menu that  
appears. Type a name and press enter. Most applications have the 
option to create a new folder from the Save or Save As dialog box.

Open application?  Mac-There are several different ways, each depending on your 
particular set up. Most commonly used applications are on the 
Dock. If the application is not on the Dock, go to the folder on your 
hard drive and double click on its icon. Or there may be an alias (a 
shortcut pointer) of the application on your desktop; in which case, 
you can double click on the alias. Or there may be a listing under 
the Apple Menu and Recent Items.  

  Windows-There are several different ways, each depending on your 
particular set up. In My Computer, navigate to the folder that 
contains your application and double click with the left mouse 
button. Or there may be a shortcut of the application on your 
desktop; in which case, you can double click on the shortcut icon 
(which has a curved arrow in its left hand corner). Or, click on the 
Start button and roll to the All Programs Menu and find your 
application under the appropriate submenu. (This is similar to 
using the Apple Menu on the Mac.) Finally, you can also double 
click on a document previously created by that application.

Open window?  Mac and Windows- Double click on the disk icon or the folder 
icon. Sometimes the icon will be large and above the name. 
Sometimes it will be tiny and to the left of the name.

Print sideways?  Mac and Windows- While your document is open, go to the File 
menu and choose Page Setup and click on the sideways icon under 
the word Orientation.

Renaming?  Mac- Single click on a file name (not on the icon) and pause for a 
second while the name darkens and a rectangle appears around the 
title; then simply type in a new name. Click anywhere on the 
desktop to deselect or press Return. Or click on the file name and 
push Return to get the rectangle around the title.

  Windows- Single click on a file name (not on the icon) and pause 
for a second while the name darkens and a rectangle appears 
around the title; then simply type in a new name. Press enter. Or 
right mouse click and choose Rename.
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 Save vs. Save As?  Mac and Windows- The first time you Save, you can choose either 
Save or Save As because you will get the same dialog box in which 
you will need to enter the Big Three (a good name, the correct 
storage destination, the correct folder) before you choose Save. 
Subsequently, choose Save or Command-S every five-ten minutes. 
Choose Save As only if you want to change one of the Big Three, 
usually because you want to change the name of the file to create a 
new version to work on.

Screen Freezes  Mac- If an application freezes, try a force quit by holding done 
Command-Option-Escape and choosing Force Quit in the dialog 
box. Force quitting allows you to close the frozen application 
without having to restart your computer. Force Quit is also a menu 
choice under the Apple Menu.

  Windows- If an application freezes, try a force quit by holding 
done Control-Alt-Delete and choosing End Task in the dialog box. 
Force quitting allows you to close the frozen application without 
having to restart your computer. If the application remains frozen, 
clicking Control-Alt-Delete again will restart.

Scroll Bars?  Mac and Windows- Almost every window has a horizontal elevator 
shaft (scroll bar) below it and a vertical elevator shaft on the right. 
Each shaft gives you 5 ways to move left/right or up/down: the 
arrows, the gray areas or the elevator car itself.

Searching?  Mac- From the desktop, choose Find from the File Menu. Use the 
arrowed buttons to fine tune the search

  Windows- Click the Start button, point to Search, and then choose 
from the left hand column, the kind of file you are looking for. 

Show/Hide an application  Mac-Under the program menu, choose Hide (name of program) or 
Hide Others

  Windows-Minimize the window by clicking on the middle of the 
three boxes on the top right of the open window.

Turning off?  Mac- Quit all applications and from the desktop under the Apple 
Menu, choose Shut Down.

  Windows- From the desktop click on the Start button and choose 
Turn Off Computer.
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Undo?  Mac- Most programs allow undoing your last action- whether 
typing, moving a graphic, formatting, etc.- by going to the Edit 
menu and choosing Undo or by typing the keyboard equivalent 
Command-Z (Remember Z for Zap). Some programs allow 
multiple undoes.

  Window- Most programs allow undoing your last action- whether 
typing, moving a graphic, formatting, etc.- by going to the Edit 
menu and choosing Undo or by typing the keyboard equivalent 
CTRL-Z (Remember Z for Zap) or sometimes if you right mouse 
click, one of the options will be Undo. Some programs allow 
multiple undoes.

Viewing Files?  Mac- Once disk window is open, choose the View Menu on the 
Finder screen. You can choose to see the names of the files by 
icons, by list, by columns. Or click on the View Options in the 
window’s Toolbar as a shortcut for the same choices.

  Windows- In My Computer, open the folder you want to inspect, 
then go to View Menu, choose Arrange Icons and then choose by 
Name, Type, Size. The View menu also lets you choose to view 
your folders by tiles, Icons, Thumbnails.

Window ... change size  Mac- Click on the green button on the top left corner of each 
window. Click to make the window full size or click to restore to 
original size.

  Windows- Double Click on the title bar to maximize size; double 
clicking again restores window to original size. Or click on the 
right hand corner symbols: the first of the three shrinks the window 
onto the Taskbar (this is called minimizing) while clicking on the 
second one makes the window fill the screen. or restores the 
window to original size.
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A short quiz for JV Mac users heading for the Varsity!
1) Describe two ways to open a file. What is the advantage of each one?
2) What are the keystroke shortcuts for: 
 CUT = Command ___ UNDO = Command ___
 COPY = Command ___ SAVE = Command ___
 PASTE = Command ___ PRINT = Command ___
3) How do you find the calculator?
4) What are the 3 things that you should remember whenever you save a file? What is the fourth 
thing that you should occasionally take advantage of, especially when you want to move a file 
from one word processor to another?
5) What is the difference between clicking the red button and choosing Quit under the File 
menu? What are the keyboard shortcuts for each?
6) How do you find out how much storage space is left on your hard drive?
7) How do you cycle through open windows?
8. How do you close all open windows quickly?

A short quiz for JV Windows users heading for the Varsity!
1) Describe two ways to open a file. What is the advantage of each one?
2) What are the keystroke shortcuts for: 
 CUT = CONTROL ___ UNDO = CONTROL ___
 COPY = CONTROL ___ SAVE = CONTROL ___
 PASTE = CONTROL ___ PRINT = CONTROL ___
3) What one keystroke using ALT is so important for closing windows and quitting applications 
that Dr. Seuss might have made up the rhyme:

Before Windows users try to learn anything more,
Horton suggests that you learn to use ALT + ___

4) What are the 3 things that you should remember whenever you save a file? What is the fourth 
thing that you should occasionally take advantage of, especially when you want to move a file 
from one word processor to another?
5) What is the difference between clicking the close box and choosing Exit under the FILE 
menu? What are the keyboard shortcuts for each?
6) Describe the use of the ALT Tab feature for dealing with multiple applications in RAM?
7) How do you find out how much space is left on your hard disk?
8) How do you minimize applications?

A short quiz for OS X users heading for the Varsity!
1) What is the Dock in OS X?
2) Where is Force Quit found in OS X?
3) How do you add an alias to the Dock?
4) How do you find the Key Caps equivalent in OS X?
5) Where is the Show/Hide applications feature in OS X?
6) How do you minimize a window? Close a window? Resize a window?
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